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Introduction to CorporateSync

CorporateSync allows you to transfer data between your calendar application
and your Palm compatible platform device. CorporateSync 2.1.2 now enables
you to synchronize your Palm with CorporateTime 5.0 or greater.

If you cannot find the installer file, contact your System Administrator. For
information on HotSync setup, consult your Palm organizer handbook.

A word about terms

Calendar server refers to the server where all Entries (Meetings, Day Events, Daily
Notes, Tasks and Holidays) exist. Calendar application refers to the application
you use to create, edit or delete these Entries (CorporateTime, OpenTime,
Netscape Calendar or Lexacom Calendar). In cases where Entries are discussed,
calendar server and calendar application are used interchangeably. Where Address
Books are discussed, only calendar application is used, as CorporateSync can only
synchronize Address Books that exist locally on a user’s machine and not on the
server.

System Requirements

*  CorporateTime Server 3.5 or greater, or Netscape Calendar Server 3.5 or
greater

*  Macintosh OS System 7.1.2 up to version 9

e 8 MB RAM minimum (64 MB recommended)

*  Palm MacPac version 2 or greater

*  Palm platform compatible device (e.g. Palm Ill, V, VII, or WorkPad)

Chapter 1 e Introduction to CorporateSync 5
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Installing CorporateSync

1. If you already have data in your Palm Desktop, you should perform a
HotSync before installing CorporateSync.

2. Run the CorporateSync installer on your computer and follow the on-screen
instructions. If you have an evaluation copy, contact Steltor for information
on obtaining a permanent copy.

3. If you have a previous version installed on your computer, the installer will
automatically locate it and overwrite it.

4. This installation replaces the Palm Desktop with your calendar application
Entry information. If you have data in the Palm Desktop, the installer will
move it to a folder entitled Disabled Conduits. Turn on the palm organizer
and place it in its cradle.

5. Press the HotSync button on the front of the palm organizer cradle. The CS
Setup application will be installed on your palm organizer.

6. Note: You may get error messages in the HotSync log saying that CS Setup
cannot be located. Ignore these messages.

7. If the HotSync Manager is running, the installer will ask if you wish to close it.
Click Yes to exit the HotSync Manager.

8. Click the HotSync icon in your HotSync folder and select HotSync Manager.

9. From the HotSync menu, choose Conduit Settings. A list of synchronizable
items appears. Choose how you want CorporateTime Events, Tasks and
Addresses to be synchronized by double-clicking on each item. A dialog box
appears.

*  Synchronize the files: Synchronize all information that exists on both
your Palm organizer and in CorporateTime.

*  Macintosh overwrites hand-held: Information in your CorporateTime
Agenda overwrites Events, Tasks or Addresses on your Palm organizer.

*  Hand-held overwrites Macintosh: Information on your Palm organizer
overwrites Entries, Tasks or Addresses on your Macintosh.

* Do Nothing: The specified Entry type is not synchronized.

10. Select a user name from the top of the Conduit Settings dialog box. If there is
only one user name, it will be selected automatically. For more information
on the Conduit Settings dialog box, consult your palm organizer Handbook.

CorporateSync is now installed but no Entry information has been synchronized.

Note: CorporateSync does not require that a calendar application be installed on

your machine. However, CorporateTime/OpenTime 4.0 or greater is required to
synchronize an off-line Agenda or Address Book.

6 Chapter 1 ¢ Introduction to CorporateSync
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Limitations

* Upgrading your Palm device to OS 3.3 may resultin loss of data if you have a
previous version of CorporateSync installed. To avoid this error, please install
CorporateSync 2.1.2 before you upgrade to OS 3.3. If you have already
encountered this error, upgrade to CorporateSync 2.1.2 to resolve the
problem.

* The palm organizer does not recognize different time zones. Make sure your
calendar application's time zone corresponds to the palm organizer’s.

*  You cannot synchronize the palm organizer's repeating Events. You can,
however, synchronize your calendar application's repeating Entries.

* Ifyouchange a timed Event to an untimed Event, or vice versa, on your palm
organizer, the change will not appear in your calendar application.

* Itis recommended that you only synchronize the palm organizer with your
on-line Agenda. Synchronizing with the off-line Agenda can (and usually
does) cause duplicate Entries. See Appendix A for details.

*  You cannot HotSync Address Book Entries when your calendar application is
open on your Macintosh.

* CorporateSync is unable to present a list of possible matches for duplicated
names. To avoid this problem, enter as much unique user information as
possible (e.g. organization unit, etc.).

Avoiding Problems

There are a few steps you can take to minimize potential problems:

*  After you upgrade to CorporateSync 2.1.2, HotSync immediately before
performing other operations.

*  When possible, create and modify your Entries using the calendar
application. This is especially recommended when dealing with repeating
Entries.

*  Setthe Private Records option in the palm organizer's Security application to
“Show”.

*  Choose Refresh all from the calendar application View menu after
performing a HotSync.

*  Select “Set as Default” in the Change HotSync Action menu to preserve the
settings you entered.

Chapter 1 e Introduction to CorporateSync 7
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Using CorporateSync

Synchronizing your palm organizer for the first time

10.

11.

12.

13.

14.
15.

Turn on your palm organizer.

Tap the CS Setup icon to open CorporateSync Setup.

Enter your calendar application user name and/or organization units in the
user field. Enter enough characters to distinguish yourself from all other
users on your server.

Enter the server name and node number or alias in the server field.
Synchronize with an off-line database by selecting Off-line instead of a server
name. If you select Off-line, the server and node fields will disappear.

Enter your calendar server password.

Choose Dates from the pick list at the top of your palm organizer. Define the
Synchronization period. Enter the range by entering From and To values or
by entering start and end dates (or a combination of both).

Choose Events from the pick list at the top of your palm organizer and select
Event options.

Select “HotSync Refused Entries” to transfer Meetings, Daily Notes and Day
Events that you have chosen not to attend or keep in your Agenda.

Select “Show Location” to transfer Meeting Locations (the default Location is
the first invited Resource).

Select “Show Attendees” to transfer the names of invited people and
Resources (maximum of 12).

Select “Limit Event Details” to limit the size of Meeting Descriptions that will
be transferred. When selected, enter the maximum size to be transferred
(maximum of 64k).

Choose Tasks from the pick list at the top of your palm organizer and select
Task options.

Select “HotSync Completed Tasks” to transfer Tasks marked as completed.
Select “Limit Task Details” to limit the size of Task Comments that will be
transferred. When selected, enter the maximum size to be transferred
(maximum of 64k).

Chapter 2 ¢ Using CorporateSync 9
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16. Choose Addresses from the pick list at the top of your palm organizer and
enter the calendar application Address Book name. Select Address options.
In order to HotSync Address Book Entries, your calendar application must be
closed on your Macintosh.

17. Place your palm organizer into its cradle and press the HotSync button. Your
palm organizer is now synchronized with your calendar application.

10 Appendix 2 ¢ Using CorporateSync
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Troubleshooting

In this chapter, we explain how to work around problems users sometimes
encounter while working with the palm organizer. When bulleted lists appear,
your problem can be fixed using one, some or all of the possible solutions.

HotSync problems

I cannot get my palm organizer to HotSync with the calendar
application.

*  Make sure your Macintosh’s HotSync Manager is on.

*  The calendar application cannot be open in off-line mode when you perform
a HotSync with your off-line Agenda. Close the calendar application or
switch on-line by choosing Work On-line from the File menu.

* Ifyou are also synchronizing Address Book Entries, the calendar application
must be closed. Ensure that the Address Book name is entered correctly in CS
Setup.

*  Close all HotSync windows on your Macintosh (e.g. HotSync Log, Custom
menu).

*  Verify the accuracy of the user name, organization units, password, server
and node settings in the palm organizer CS Setup.

*  Make sure the user name, organization units and initials you entered
distinguish you from everyone else on the system.

*  Verify that your palm organizer is placed properly in its cradle.

*  Make sure the HotSync Custom settings for calendar application Addresses,
Entries and Tasks are not set to “Do Nothing”.

*  Make sure the server you are connecting to is running properly.

Chapter 3 e Troubleshooting 11
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*  Verify the Serial Port settings using the Setup dialog box (opened when you
click the HotSync manager icon near your Macintosh’s Finder and choose
Setup). Make sure no other programs are using the same Com Port as
HotSync.

*  Close the HotSync Manager and then open it again.

I have problems connecting to the server.

*  Make sure the user name, organization units, server name, password and
node number have all been entered properly in the palm organizer CS
Setup.

*  Make sure that you are using the right HotSync option in the HotSync
application (Local Sync vs. Modem Sync).

*  Ensure that the server you are connecting to is running properly.

*  Verify that your palm organizer is sitting properly in its cradle.

* If you are synchronizing calendar application Addresses, your off-line and
on-line passwords must be the same.

The HotSync keeps timing out.

Open the palm organizer’s HotSync application. Hold down the Up and Down
buttons and tap the top-right corner of the screen. The Developer’s Back Door
dialog box will open and the message “DLServer Wait Forever is ON” will appear.
Tap OK.

The HotSync is taking too long.

Cut down the synchronization time by doing the following:

*  Setunused applications to “Do Nothing” in the HotSync Manager Custom
menu.

* Narrow the time period you want to HotSync in the palm organizer CS
Setup.

12 Chapter 3 ¢ Troubleshooting



CorporateSync 2.1 for Palm, Macintosh Edition User’s Guide

Entry problems

Some palm organizer Entries do not appear in the calendar
application after synchronizing.

*  Choose Refresh all from the View menu in the calendar application.

*  Only the first Event of a repeating Event created using the palm organizer
appears in the calendar application.

* The Entries are outside the range defined in the palm organizer CS Setup.

Some the calendar application Entries do not appear in the palm
organizer after synchronizing.

*  Set Private Records in the palm organizer Security application to “Show”.

* The Entries are outside the range defined in the palm organizer CS Setup.

*  Check the Entries and/or Tasks HotSync settings in the palm organizer CS
Setup. Select the desired options and HotSync again.

What happens to an Entry that has been modified in both the
calendar application and the palm organizer when I perform a
HotSync?

When a HotSync is done and the Custom menu setting for the calendar
application is “Synchronize the files”, the Entry is duplicated (for more
information about the duplication, open the HotSync Log). Simply delete the
unwanted Entry (either on your palm organizer or in the calendar application)
and HotSync again.

I changed a timed Event into an untimed Event (or vice versa) in
my palm organizer but the change was lost when I performed a
HotSync.

The calendar application does not support this kind of change. You must delete

the Event and then create a new one for the calendar application to recognize it
after the next HotSync.

Chapter 3 e Troubleshooting 13
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I created an untitled Event using the palm organizer but I cannot
find it.

It was never created. Unless a Note or a Location (entered in the palm organizer
using parentheses on the time line) is included with an untitled Event, the Event
will not be created.

I keep getting multiple copies of my Entries.

* If you modified an Entry in both the palm organizer and the calendar
application, Entries will be duplicated when you do a HotSync and the the
calendar application Events setting in the Custom menu is “Synchronize the
files”. Simply delete the unwanted Entry (either on your palm organizer or
in the calendar application) and HotSync again.

e This will happen when you synchronize your palm organizer to your off-line
Agenda and then reconcile your off-line Agenda with your on-line Agenda
before synchronizing your palm organizer and the on-line Agenda. See
Appendix A for more information.

* If a HotSync stops with an unexpected error, power loss, etc., it is possible
that some Entries will be duplicated the next time you HotSync.

Changes I made to an Entry in my palm organizer were not
transferred to the calendar application.

* Ifit was an instance from a series of repeating Events, it will never be
transferred to the calendar application. the calendar application only
modifies the original Event.

* Change the the calendar application setting in the Custom menu to
“Synchronize the files”.

When I modify a repeating Event on my organizer that was created
in the calendar application, some changes are applied to all
instances, while others only to the modified instance.

The Title, Location, Times and Reminder will only change in the instance you
modify. Deleting an Event on the palm organizer only deletes that one instance.
To change these settings for all instances at once, you have to use the calendar
application. Notes and Access Levels will be modified for all instances of the
Event.

14 Chapter 3 ¢ Troubleshooting



CorporateSync 2.1 for Palm, Macintosh Edition User’s Guide

I am having trouble with repeating Events created on my palm
organizer.

The Palm organizer and the calendar application handle repeating Entries
differently:

e Currently, the only way to have repeating Events appear in both the calendar
application and the palm organizer is to schedule them in the calendar
application and HotSync. If you need to schedule repeating Events using
your palm organizer, you have to create each instance separately for them to
appear in the calendar application.

* If you created repeating Events in the palm organizer and the Custom menu
setting for the calendar application is “Synchronize the files”, only the first
one will appear in the calendar application. All instances will remain in the
palm organizer.

* If you delete the first repeating Event in the palm organizer, only the original
Event will remain on your palm organizer if your HotSync setting for
calendar application Entries is “Desktop overwrites the palm organizer”.

* If you delete the lone instance that was transferred to the calendar
application, all instances of that Entry will be deleted if your HotSync setting
for the calendar application Events is not “Do Nothing”.

Events on my palm organizer get rescheduled after I synchronize.

Itis important that the time you enter on your palm organizer corresponds to the
the calendar application time zone entered in your calendar application.

I want to delete all Events on my palm organizer.

e Delete them manually or on an Entry-by-Entry basis.

*  Setatime range in your palm organizer’s CS Setup where no Entries exist
and synchronize with the calendar application HotSync settings set to
“Desktop overwrites handheld”.

e Perform a hard reset. Warning: Do this only if you want to delete Events from
all user-installed applications on the palm organizer, along with all
information you have entered. Consult the palm organizer Handbook for
more information.

Chapter 3 e Troubleshooting 15
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I want to tell my palm organizer what Address Book Entry address
to keep.

If you only have either the Business or Personal address entered in your calendar
application Address Book, it will choose that one by default. If both addresses are
entered, the Default address value selected in the palm organizer CS Setup is
used.

How does my palm organizer deal with my Address Book Entry
phone numbers?

Your palm organizer tries to recognise phone numbers as best as it can. If it
cannot find a valid international phone number combination, everything is
entered in the the calendar application phone number field. A blank space, dash
or period can separate parts of the number. An x or # can be used to identify
extensions. The following are examples of valid phone number combinations:

555-5555 5555555 (555) 555-5555
55 (555) 555-5555 555-5555 #555 55.55.55.55
55-55-55 555-55-55 55555555x555

There is an extra x or # beside some phone extension numbers on
my palm organizer.

You probably entered the extra character in your calendar application Address
Book. Open the Address Book and delete the extra character manually from the
Extension edit box. The next time you HotSync the extra character will be gone.

Other problems

There is not enough space to enter my user name and organization
units.

Itis long enough; the typing simply scrolls off-screen. To view all the characters

on screen at once, open the Keyboard (CS Setup > Edit menu > Keyboard) and
type the information there.

16 Chapter 3 ¢ Troubleshooting
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My palm organizer keeps freezing up.

Do a soft reset by gently pressing the reset button with the tip of a paper clip.

Every time I try to HotSync, I get an insufficient disk space error.

You must free up more space on your Macintosh’s hard drive. It is recommended
that users have at least 5MB of hard disk space available .

How do I delete CS Setup from my palm organizer?

Select Memory from the palm organizer menu.
Choose Delete apps.

Select CS Setup and tap Delete.

Tap Yes to delete.

HwnN =
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Appendix

Synchronizing your off-line Agenda

Synchronizing your palm organizer with your off-line Agenda and
sending that information your on-line Agenda

e m

Cff-i na‘.ﬁgenda On-line Aganda (Server)

FaimPilot

1. Synchronize the Palm organizer with your off-line Agenda. Agenda Entries
are titled “A” on both.
Upload your off-line Agenda information to the calendar server.

3. Synchronize your Palm organizer with your off-line Agenda. Set the Ctime
Custom Action to Desktop Overwrites Palmtop. The Entry titled “A” now
exists on both and has a Ctime Event ID.

Appendix A e Synchronizing your off-line Agenda 19
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Why you might end up with duplicate Entries

I:Iﬁ—:%!lz

Cff-li ne‘.ﬁgenda On-line Agenda (Sarer)
|
Wy
PaimPiiot

1. When you synchronize the Palm organizer with your off-line Agenda,
Agenda Entries are titled “A” on both.

2. When you upload the data to the server, the server assigns Event ID “X” to
“A”.

3. The nexttime you synchronize your on-line Agenda with the Palm organizer,
you will end up with two Entries called “A”. This is because the server does
not recognize that the Entry with ID “X”is actually the same as the Palm
organizer Entry titled “A”.

20 Appendix A ¢ Synchronizing your off-line Agenda
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Synchronizing your Palm organizer with your on-line and off-line
Agenda

HwnN s

10.
11.

]

i}fr-luna‘.ﬂgenda On-line Agenda (Servear)

FPaimPilot

Create your meetings, address book entries or tasks using your Palm.

Then, synchronize your Palm organizer with your off-line Agenda.

Log on to CorporateTime.

On the Options menu, select off-line, select Download and click Do not
download. Then, click OK.

When CorporateTime prompts Would you like to update the host Agenda?,
click Yes.

On the File menu, click Download To local file.

Then, click OK when you are prompted Your are about to start downloading
your agenda, would you like to continue?

Open HotSync Manager, and select Custom.

Click CorporateTime Addresses, select Change and then click Desktop
overwrites handheld. Select the Set as default check box. Then, click OK.
Now repeat step 8, for your CorporateTime Events and CorporateTime
Tasks. Click Done when you are finished.

Now synchronize your Agenda on-line.

Then, change your CorporateTime Addresses, CorporateTime Events and
CorporateTime Tasks to Synchronize the files. Then select the Set as default
check box.

Appendix A e Synchronizing your off-line Agenda 21
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Note To avoid creating duplicate entries, we recommend synchronizing your
Palm with your on-line and off-line Agenda after creating new Meetings, Address
Book entries or Tasks on your Palm.

22 Appendix A ¢ Synchronizing your off-line Agenda
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Appendix

Field Mapping

This section describes the conversions that occur when transferring data between
the calendar application and your palm organizer’s Date Book, Address Book and
To Do List. Apart from the special conversion rules that apply to specific fields,
some general rules apply:

* Textfields are cut to the maximum allowed length on the destination
platform.

* Dates that are not within the representable range of dates on the destination
platform will get changed to the nearest representable date.

*  Details from the calendar application are truncated to the “maximum note
size” before being sent to a palm organizer note.

If the user changes a field on the palm organizer which he or she does not have
the right to change in the calendar application (e.g. changing the time of an

Event the user does not own), the change is rejected and the affected field is
copied from the calendar application back onto the palm organizer.

Entries

Converting a calendar server Entry into a palm organizer Date Book item:

calendar Palm field Notes
server field
Title Description

Appendix B e Field Mapping 23
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calendar
server field

Palm field

Notes

Location

Description

If the “Show Location” flag is set, the calendar
server Entry’s location is enclosed in parentheses
and appended to the Palm Event's description,
after its calendar server title. If the flag is not set,
the calendar server Entry's location is ignored.

Detail

Note

If the calendar server Entry is a Meeting, then its
detail is copied to the Palm Event's note. If itis a
Day Event or Daily Note, it is ignored. Also, if the
“Show Location” flag is set and there is more than
one attendee or its sole attendee is not the login
user, then a textual list of attendee names is
created and added to the Palm Event's note
(which may or may not have been copied from the
calendar server Entry's detail, depending on the
Event's class).

Start Time

Date / Start
Time

The calendar server Entry's start time is split into
two parts: the date and the time-of-day on that
date. The date is always placed into the Palm
Event's date field. If the calendar server Entry is a
Meeting, then the time-of-day is placed into the
Palm Event's start time. If the calendar server Entry
is anything besides a Meeting (e.g. Day Event,
Daily Note, Holiday), the Palm Event becomes an
untimed Event.

Duration

End Time

If the calendar server Entry is a Meeting, then its
duration is added to its start time's time-of-day,
and the result placed in the Palm Event's end time.
The Palm does not allow Events to cross day
boundaries. If that happens, the Event is truncated
to end at midnight before being copied to the
Palm (this does not affect the calendar server
Entry).

24 Appendix B ¢ Field Mapping
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calendar
server field

Palm field

Notes

Reminder

Alarm

If the calendar server Entry does not have a
reminder, the Palm Event does not get one either
and the calendar server Entry’s reminder length is
checked. If it is a multiple of 1440 (the number of
minutes in a day) or is greater than 7620 (the
number of minutes in 127 hours), the Palm Event's
alarm unit field is set to “Days”. If it is a multiple of
60 or is greater than 127, the Palm Event's alarm
unit field is set to “Hours” and the Palm Event's
alarm unit field is set to “Minutes”. The calendar
server Entry’s reminder length is then converted
into the proper units. If the resulting number is
greater than 127, it is changed to 127. This
number is used in the Palm Event's alarm amount
field.

Access level

Private flag

If the calendar server Access level is Personal, the
Palm Task's private flag is turned on. If the Access
level is anything else, the Palm Task's private flag is
turned off.

Repeat

Repeating Entries on the calendar server are
always copied as individual instances, so this field
is set to “No Repeat”.

Converting a Date Book item on the palm organizer to the calendar application:

Table 1;

Palm field

calendar
server field

Notes

Description

Title

If the “Show Location” flag is set, the Palm Event's
description is divided in two: a title part and
location part. If the flag is not set, the entire Palm
Event's description becomes the title part. If the
calendar server Entry has an instance title, the title
part is used as the instance title. If not, it is placed
in the calendar server Entry 's title.

Description

Location

If the “Show Location” flag is set, the Palm Event's
description is split into two parts: a title part and
location part. The location part is placed in the
calendar server Entry’s location. If the flag is not
set, the calendar server Entry's location remains
unchanged.
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Table 1;

Palm field

calendar
server field

Notes

Note

Detail

If the “Show Attendees” flag is set, the Palm
Event's note is split into two parts: an attendee
part and a note part. If not, the entire Palm Event's
note becomes the note part. The attendee part is
discarded. If the calendar server Entry is a Meeting,
then the note part is copied to the calendar server
Entry's detail. If not, it is ignored.

Date / Start
Time

Start Time

The Palm Event's date (and its start time, if it is not
an untimed Event) are merged and placed into the
calendar server Entry's start time. Note that if the
Palm Event is changed from a timed Event into an
untimed one or vice versa, that change is rejected
and its original state is restored. (This is because it
would amount to changing the class of a calendar
server Entry, which we do not support.)

End Time

Duration

If the calendar server Entry is a Meeting, then the
Palm Event's date, start time and end time are
combined to calculate its duration, which is then
placed in the calendar server Entry's duration field.

Alarm

Reminder

If the Palm Event does not have a reminder, the
calendar server Entry does not get one either. If it
does, the Palm Event's alarm amount is converted
to minutes and placed in the calendar server
Entry's reminder length field. If the Palm Event's
alarm unit is “Minutes” or “Hours”, then the
calendar server Entry's reminder type is set to
“Popup Window”. If the Palm Event's alarm unit is
“Days”, then the calendar server Entry's reminder
type is taken from the user's Entry defaults. Finally,
if the default reminder type is “No Reminder”,
then the type is set to “Display Upcoming”.
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Table 1;

Palm field calendar Notes
server field

Private flag Access level If the Palm Event's private flag is turned on, then
the calendar server Entry's Access level becomes
Personal. If the Palm Event's private flag is turned
off, the calendar server Entry's Access level comes
from the user's Entry defaults, unless the default
Access level is Personal (the calendar server Access
level is set to Confidential in this case).There is an
exception to this rule: If the Palm Event's private
flag is turned off and the flag has not changed
since the last sync, and the calendar server Access
level is anything except Personal, the calendar
server Access level remains unchanged.

Repeat Repeating Events on the Palm are ignored. They
are treated as if they were single-instance Events.

Tasks

Converting a the calendar application Task into a To Do item on the palm

organizer:

calendar Palm Field Notes

server field

Description Description

Detail Note

Due Date Due Date

Priority Priority If the calendar server priority is between 1 and 5, it
maps to the same priority on the Palm. If the
calendar server priority is anything else, it maps to
priority 5 on the Palm.

Completion Completed A calendar server completion level of 100% level

level flag flag maps to the Palm's completed flag being
turned on. Any other completion level, the
completed flag is turned off.
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calendar Palm Field Notes
server field
Access level Private flag If the calendar server Access level is Personal, the

Palm Task's private flag is turned on. If the Access
level is anything else, the Palm Task's private flag is
turned off.

Category The To Do gets the default (“Unfiled”) category.

Converting a To Do item on the palm organizer into a the calendar application
Task:

Table 2:

Palm field calendar Notes
server field

Description Description

Note Detail

Due Date Due Date If there is no due date, any existing calendar server
due date reminder is removed. If a due date is
specified, a calendar server due date reminder is
created if it does not already exist. Its type and
length are taken from the user's defaults.

Priority Priority The Priority level maps directly, with the following
exception. If the Palm priority is 5, and it has not
changed since the last sync, and the calendar
server priority is anything else, then the calendar
server priority remains the same.

Completed Completion | The Palm completed flag maps to a calendar

flag level server completion level of 0% or 100%, depending
on the state of the flag. There is an exception to
this rule, however. If the Palm completed flag is
off, and it has not changed since the last sync, and
the calendar server completion level is between
1% and 99%, the calendar server completion level
stays unchanged.
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Table 2;

Palm field

calendar
server field

Notes

Private flag

Access level

If the Palm Task's private flag is turned on, then
the calendar server Task's Access level becomes
Personal. If the Palm Task's private flag is turned
off, the calendar server Task's Access level comes
from the user's Task defaults, unless the default
Access level is Personal (the calendar server Access
level is set to Confidential in this case). There is an
exception to this rule: If the Palm Task's private
flag is turned off, and the flag has not changed
since the last sync, and the calendar server Access
level is anything except Personal, the calendar
server Access level remains unchanged.

Category

The Palm Task's category is ignored.

Address Book Entries

Address book Entries in the calendar application are categorized as business

Entries and personal Entries on your palm organizer. If a the calendar application
Entry has a business address only (i.e. no home address), that Entry is considered
a business Entry. Conversely, if the Entry has a home address only, itis considered

a personal Entry. If an Entry has both addresses, its category is taken from the

“Default” value in CS Setup. Finally, if an Entry does not have any addresses, it is

considered an “unknown” Entry.

Converting a calendar application Address Book Entry into a palm organizer

address:
Table 3:
calendar Palm field Notes
application
field
category Business Entries in the calendar application are

placed in the “Business” category. Personal Entries
in the calendar application are placed in the
“Personal” category. Unknown Entries are placed
in the “Unfiled” category.
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Table 3:

calendar Palm field Notes

application

field

Last name Last name

First name First name

Assistant

phone

Business 1 A phone field | See below

Business 2 A phone field | See below

Fax 1 A phone field | See below

Fax 2 A phonefield | See below

Home 1 A phone field | See below

Home 2 A phone field | See below

Mobile 1 A phone field | See below

Mobile 2 A phone field | See below

Pager A phone field | See below

E-mail 1 A phonefield | See below

E-mail 2 A phone field | See below

Street Address Business or home address, depending on Entry
category.

City City Business or home address, depending on Entry
category.

Prov/State State Business or home address, depending on Entry
category.

Zip/Code Zip Code Business or home address, depending on Entry
category.

Country Country Business or home address, depending on Entry
category.

Relationship | ---

Title Title

Company Company

Department | ---
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Table 3:

calendar
application
field

Palm field

Notes

Office

Assistant

Industry
Type

Account #

Birthday

Anniversary

Custom
Date 1

Custom
Date 2

Nickname

Spouse

Personal
Notes

User 1

Custom 1

User 2

Custom 2

User 3

Custom 3

User 4

Custom 4

Notes

Note

Private Flag

Ignored. The calendar application currently does
not support security on a per-address basis.

Telephone fields on the palm organizer are allocated according to a fixed order.

For each telephone number present in the the calendar application Entry, a

telephone field on the palm organizer is allocated (up to a maximum to five) and

given a corresponding label.
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For business Entries, the order of allocation is as follows:

Table 4:
calendar application Telephone # Palm Label
Business 1 Work
Home 1 Home
Fax 1 Fax
E-mail 1 E-mail
Mobile 1 Mobile
Pager Pager
Business 2 Work
Home 2 Home
Fax 2 Fax
E-mail 2 E-mail
Mobile 2 Mobile

For personal Entries, the order of allocation is as follows:

Table5:
calendar application Telephone # Palm Label
Home 1 Home
Business 1 Work
Fax 1 Fax
E-mail 1 E-mail
Mobile 1 Mobile
Pager Pager
Home 2 Home
Business 2 Work
Fax 2 Fax
E-mail 2 E-mail
Mobile 2 Mobile
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Converting a palm organizer address into a calendar application Address Book

Entry:
Table 6:
Palm field calendar Notes
application
field

Category The category is used to determine which address
(business or home) to synchronize with.

Last name Last name

First name First name

Phone 1 Business1 See below

Phone 2 Business 2 See below

Phone 3 Fax 1 See below

Phone 4 Fax 2 See below

Phone 5 Home 1 See below

Address Street Business or home address, depending on Entry
category.

City City Business or home address, depending on Entry
category.

State Prov/State Business or home address, depending on Entry
category.

Zip Code Zip/Code Business or home address, depending on Entry
category.

Country Country Business or home address, depending on Entry
category.

Title Title

Company Company

Custom 1 User 1

Custom 2 User 2

Custom 3 User 3

Custom 4 User 4

Note Notes
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Table6:
Palm field calendar Notes
application
field
Private flag Ignored - The calendar application currently does
not support security on a per-address basis.

Palm organizer telephone numbers are transferred to the calendar application
depending on (1) their position and (2) their label. For example, the second
telephone with a label of “Mobile” will end up in the “Mobile 2" field in the
calendar application. The complete list of possibilities is as follows:

Table7:
1st Occurrence on Palm Maps to
Work Business 1
Home Home 1
Fax Fax 1
Other
E-mail E-mail 1
Main
Pager Pager
Mobile Mobile 1
Table 8:
2nd Occurrence on Palm Maps to
Work Business 2
Home Home 2
Fax Fax 2
Other
E-mail E-mail 2
Main
Pager
Mobile Mobile 2
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